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FCC Class B Radio Frequency
Interference Statement .

NOTE : This equipment has been tested and found to comply with

the limits for a Class B digital device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This equipment
generates. uses and can radiate radio frequency energy and. if not
installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment
does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged
to try to correct the interference by one or more of the following
measures -

— Reorient or relocate the receiving antenna.
— Increase the separation between the equipment and receiver.
— Connect the equipment into an outlet on a circuit different from that

to which the receiver is connected.
— Consuit the dealer or an experienced radio/TV technician for help,

NOTICE
Any changes or modification not expressly approved by the
party responsible for compliance could void the user’s authority

to operate the equipment.
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Flatbed Scanner User’s Manual

Introduction

This product is a multi-function desktop flatbed scanner that
scans color as well as black and white photographs, drawings and
text. Hardware resolution of the scanner is 600 x 1200dpi, while
software enhanced resolution can reach up to 9600 x 9600dpi.
Using the software accompanying the scanner can produce high
quality, high efficiency, multi-functional images and documents.
This product meets FCC Class B, CE, UL, CSA, TUV, VCCI-2,
New Zealand, Australian and Northern European testing
standards as a safe, energy efficient desktop scanner.

System Requirements

Suggested system specifications:
586-133 CPU or higher;
32MB or more DRAM;
VGA monitor;
200MB or more free disk space



(2) Scanner parts:

[—> Scanning platform cover

Scanning platform

Power switch

Power source
indicator light

ptor |

Connect to PC

Power switch -1-—

Connect to Printer
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Scanner Features

3 dimensional object scanning

Auto frame-size selection for commonly used document,
photograph and name card sizes

Using an optional transparency kit, slides, transparencies and
negatives can be scanned

Fast scanning speed

Auto descreening (eliminate image ripple)

Pre-scan editing



(3) Procedure for locking (refer to the figure)

® Switch the scanner power to ON, ensuring that the cathode
lamp assembly isin the START position (at the upper area
of the scanner flatbed)

® Switch the scanner power to OFF

@ Push in the locking switch to the position indicated by a **

symbol

NOTE: Always locks the scanner when moving it in order to

avoid damaging the device. Unlock the scanner before using it.




Chapter 1  Scanner Accessories

(1) Enclosed Scanner Accessories

Parallel port type scanner

Application software

"~ 25Ppinsignal cable

Scanner
(Parallel port type)

User's manual

Adaptor

NOTE: The transparency kit is an option, the user can purchase it

separately.



Chapter 3 Setting up the Scanner

Paraliel port type scanner

Please ensure that the onboard parallel mode is set to the highest
efficiency setting. The onboard parallel mode setting can be
found in the INTEGRATED PERIPHERALS or CHIPSET
FEATURES SETUP menu of the BIOS CMOS SETUP
UTILITY. The ranking of most efficient to least efficient settings
is as follows: EPP-EPP/SPP-EPP/ECP-Normal.

(1) Connect the scanner to the computer using the
transmission cable while the power is off. Securely
attach the cable.

(2) Connect the adaptor to the scanner and plug into power
socket.

(3) Turn the PC and scanner power switches ON.

(4) Install the application and scanner driver software.,



Chapter 4:  Installation of Driver and Application Software

(1) Installing with the AUTO RUN feature from the applications
CD-ROM

1. Turn on your computer and go into the MS Windows
operating system.

2. Place the CD in the CD-ROM drive.
3. Select the appropriate language version.
4. Select the directory for the program installation.

5. Select the program and functions that you wish to install,
following the instructions of the installation wizard

program.

(2) Installing without the AUTO RUN feature from the
applications CD-ROM

1. Turn on your computer. If the computer is already ON,

then exit all applications.
2. Launch MS-Windows.

3. Place the CD in the CD-ROM drive.




Chapter 2 Scanner Placement / Locking and Unlocking

(1) Placement of the Scanner
® Place the scanner on a flat, stable surface.
® Avoid placing scanner in direct sunlight.

® Do not set heavy objects on the scanner lid in order to avoid

damage.

(2) Procedure for unlocking (refer to the figure)

® Switch the scanner power to OFF

® Pull out the locking switch to the position indicated by a **

symbol



4. In Windows 95, click START, then select RUN or, in
Windows 3.1, choose FILE from the File Manager
application; then click RUN.

5. Enter D:\Install and click ENTER.
6. Select the appropriate language version.

7. . Follow the installation wizard’s instructions to complete

the installation process.

The installation process appears on your screen as follows:

The following screen lets you know that the computer is
installing IMS Shell.
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When you see this screen, click NEXT to continue the

installation process.

When this screen shows up, you need to key in some
information to register for the product.

.




Click YES here to show that your registration information is

correct.

If you want to install to this directory, click NEXT. If you
want to install to another directory, click BROWSE. If you
want to cancel IMS Shell installation, click CANCEL.
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Use your mouse to check or delete files from among those
listed.

Choose a Program Folder name to install IMS Shell.

13
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IMS Shell Serp

M8 Enhancar  1MS Shell

When you see this screen, the installation process is
complete.
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Installing the Scanner Driver
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When this screen appears, you need to click NEXT to
continue the installation.

SETUP PROGK 137
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Information

When this screen appears, the driver installation is
completed. Click the OK button to finish the installation.
The software is now ready to use.
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Chapter 5 Scanner Operating Instructions

(1} Basic Features

1.

This device is a desktop scanner.

The largest possible scanning area is 8.5 X 11.7 (inches).

You can scan in commonly used document sizes such as
Letter, A4, BS and all standard size photographs and
business cards.

Optical resolution is 600 X 1200 dpi; emulation
resolution can reach 9,600 X 9,600 dpi. The scanner can
provide 30 bit high quality color images.

There is a choice of several scanning modes to
accommodate any type of document processing (color,
grayscale, line art and dither mode).

(2) Scanner Functions

1.

Document Scanning; The scanner can utilize OCR
(Optical Character Recognition) which converts scanned
documents into text documents.

Image Scanning: Desktop backgrounds, personalized
greeting cards, visual presentations, archiving,
exhibiting photographs and image layout.
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Personal Automated Office: Create files and document
folders as well as manage photographs and images. The
scanner coordinates with the printer and modem to act
as a copier, fax machine or Email delivery tool.

(1) How to Use the Scanner

(A) Operations Guide

1.

Complete installation of hardware and software by

following instructions in the installation manual.
Unlock the scanner (refer to the installation manual).

Turn the scanner power ON-—the power indicator lights

up.

Place the image face down on the scanning surface using
the start arrow as a guide (refer to page36).

If this is the first time you use the scanner, first use
Select Source (which is usually found under the File
menu) and choose E-Scanner 32 Vx.xxx (Windows 95

users) or E-Scanner 16 Vx.xxx (Windows 3.1 users)

NOTE: x.xxx is the code number for the driver version.
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Users can easily update their driver version (refer to page20).

6.

10.

11.

Select Acquire and enter the user interface. (refer to
page 20)

Select scanning mode according to the type of object
scanned and your requirements. Select Color, Grayscale,
Line Art or Dither. If you want to use OCR (Optical
Character Recognition), you must use Line Art at 300
dpi or higher (refer to page 23).

When scanning in Color mode, select the image source

-as PHOTO or PRESS in order to decide whether or not

to run the descreen function (refer to page 22)

Click on PRESCAN in order to edit the scanning area.
The user can designate the size of the area to be scanned,
the resolution, brightness, contrast, magnification and

quality (refer to page 24).

When you have finished settings for the image to be
scanned, click SCAN to perform a final scan (at this
point, a progress bar will appear on the screen). When

the progress bar disappears, the scanning is complete.

Clicks ON/OFF to exit the scanner user interface (UI)
and return to the application.




(B) Introduction to Scanner User Interface

The scanner user interface (pictured above) simulates the
appearance of many home video and audio devices in
order to make the users feel comfortable in using the
scanner.

The preview screen (as seen on the lefi-hand side of the
above figure) allows the user to see and select desired
portions of the image.

The user can upgrade to the latest version of the driver
application by visiting the website at www.e-lux.com,
and clicking DRIVER, whereupon the required
application can be downloaded.
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Introduction to the icons and their functions i‘

Preview window: Displays the prescanned image.

-Logo: Click on the logo to view scanner driver i

information, release notes and to refer to online help. You can

use the mouse 1o drag this area to change the location of the

window on the screen.

mage Size: By clicking this icon, the user can quickly
select a preset document scanning size. There is a choice of
A4/BS5 and Letter for documents and 3X5/4X6/5X7/5X3/6X4
and 7X5 for photographs or business card size.

jIPower: Click on this icon to close the UI (user

interface).

21




Document Type: Select whether the document that
you want to import is a PRESS image (se. printed) or a PHOTO.
If you select PRESS, you will enter the descreen mode. Using
this function, you can quickly eliminate Moir* patterns normally
accentuated when scanning in printed images. To select 3D
object scanning, the scanner will procure a good 3D effect.
While using transparency, user will have 4 choices of exposure

time 1, 2, 4, 8 to get the best scanning effect.

rescan: Click this icon to observe what’s present in

the complete scanning area of the Preview Window.

Scan: To scan a final image with the set parameters.

oom: Magnifies a selected area of the preview

window to allow for precise choice of details to be scanned.
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Color Piclure

Image Types: Displays the selected
image type. You can select a type from the pop-up menu. There
are four image types available using this system:

(1) Color picture: Color image scan.

(2) Grayscale: This function is used to obtain black and white

images, complete with shades of gray.

(3) Line Art: This is used to obtain pure black and white
images.

(4) Dither: To create halftone images. When printing, more
dots will be placed in darker regions and fewer dots will
be placed in lighter regions in order to create the
impression that the selection is a grayscale image. Images

found in newspapers are halftones.

Resolution: The desired resolution
of the image can be selected as a dpi value. You can choose
from a list of preset resolutions or you can enter a desired dpi

value in the custom area.

23
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Interpolated Resolution: Using software to boost the resolution.
The optical resolution of this scanner is 600 dpi. If the user
selects a resolution greater than 600 dpi, then the software will
increase the resolution according to mathematical calculations.
This function refers to a scaling ratio to adjust the image size
(refer to next item). The user can increase or decrease the size

and resolution of the imported image as desired.

age Information: Displays
many different types of information about the image such as:
width, height, scaling ratio and image size. The scroll bar ¢can
increase or decrease the size of the imported image according to
its ratio with that of the original image. Users can select the units

of the image based on the requirements in the pop-up window.

NOTE: When increasing the size of an image, take note of the
file size of the image in order to avoid not having enough
available hard disk space, which could lead to a system crash.

Image Parameter Setup Icon: There

are four tuning tools to enhance the quality of an image, namely
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Color Balance, Gamma Correction, Brightness and Contrast.

(This function is only available for images when Color Picture is

selected.)
The operating steps are as follows:

(1) After Prescan is complete, select the desired scanning
region. Click ZOOM to magnify the scanning region.

(2) Click the Advance icon in order to enter the Tuning

window.

(3) By moving the scroll bars, you can adjust the image’s
parameters to your satisfaction. (If you are unsatisfied
with your adjustments, you can click RESET to return to

the original settings.).

(4) Click OK to return to the main user interface screen to

initiate the final scan process.

mrightness: Adjust the brightness of

the image by moving this slider.

_Contrast: Adjust the contrast of the

image by moving this slider.
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-Auto: The Auto automatically defines the lightest

and darkest pixels in each channel as white and black, and then
redistribute the intermediate pixel values proportionately. In
general, the Auto feature gives good results when a simple
contrast adjustment is needed to an image with an average
distribution of pixel values; however, this feature does not
provide the more precise control that can be achieved by adjusting

the Levels or Curves controls manually.
(C) IMS Shell Manual

The IMS Shell provides an easy-to-use environment where data
from digital input devices can be transferred to OLE applications,
such as IMS Enhancer, IMS Show, MS Word, OCR programs,
business card readers, and MS Exchange. IMS Shell is also an
easy-to-use data management system for all types of files
including images, text, audio, and animation. '

IMS Shell supports and manages all types of data including
images, text, audio, and animation.
Features an all-graphic user interface.
Easy drag-and-drop design simplifies locating objects in

. folders and opening applications.
Allows user to link with and open other applications
without exiting IMS Shell.
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Shopping Cart allows user to collect objects from different

folders and move them to an application.
Folders allow user to manage a large number of objects.

IMS Shell Preface

Main IMS Shell Screen:

" IMS Shell

Falche

@ Title Bar: This area displays the name of the software,

namely IMS Shell.
@ Function Bar: This area displays all of the IMS Shell's

function buttons.

27
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Tool Bar: This area displays several frequently used
function buttons of the IMS Shell, such as "Find" and
"Acquire Image."

Application Bar: This area displays icons of all the
selected applications that are already linked with the IMS
Shell.

Shopping Cart: A unique feature of the IMS Shell, the
shopping cart can be used to collect objects from different
folders.

Recycle Bin: Temporarily holds objects which user would
like to delete.

Icon Area: The window on the right side of the working
space displays iconized images of objects contained in
open folders. Double-click on an icon to view the real size
Image.

Folder Area: The window on the left side of the working
space displays in the form of icon folders that the user has
created. When IMS Shell is opened for the first time, a
preset folder containing example objects will be displayed
here.
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The following are the functions of icons on the Tool Bar:

- Clicking here will create a new folder. The new
folder will appear at the end of the list of folders. You can

create any number of new folders.

Clicking on this icon will delete all objects in the

currently open folder.

ERIClick on this icon to add new objects to the currently
open folder. After a dialog box appears, you may select objects
to be added from the file icon list.

i Clicking on this icon will delete selected objects from

the open folder.

&dClick on this icon to save an object in another

location or under a different name.

29
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his button is used to find an object. A dialog box
will appear after clicking on the icon, and the user may then
type in the name of the object to be found.

~AClicking on this icon will activate the scanner's Twain

driver and acquire an image from the scanner.

box to appear. Click on "OK" after selecting a printer, and the

icons in the open folder will then be printed out.

his button may be used to add or delete applications.

“JClick here to open on-line help.

30



IMS Shell User Guide
How to create a new folder and add objects to the folder

A preset folder will appear in the folder window when you
first start IMS Shell. You may add items to this folder or to a

new folder you have created yourself.

To add objects to a folder, click on "Add Object” under
the File menu.

Select objects to be added from the "Add Object” dialog
box.

Click on "OK" to confirm selected objects. The dialog
box will close and the IMS Shell will reappear.

You may also use an image acquired from the scanner as
an object to be added. Click on the "Acquire Image”
button to acquire the desired image.

You may only add audio, text, and animation files that
have already been saved on disk.

To create a new folder, you may click "New Folder"
under the File menu.

A new folder icon will appear on the final page of the list
of folders.

To open any folder, click on the folder’s icon.
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How to easily manipulate objects b y dragging and dropping
them

Rearranging objects
You can use drag and drop to arrange objects in any
order you wish. To drag and drop an object, first press
the left mouse button and hold it down while the cursor is
over the object. Move the object to the desired position
and release the left mouse button.
You can drag objects from one folder to another.

Dragging objects to applications

& Press the left mouse button and hold it down while the
cursor is over the object to be moved.

& Drag the object to the desired application and release the

left mouse button.
How to perform batch processing

The Shopping Cart is an innovative feature of the IMS Shell
that allows you to perform batch processing of objects from
different folder.

Drag objects from different folders and drop them in the

Shopping Cart for lemporary storage.

Drag the Shopping Cart to the desired application. This
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will open the application and cause it to process the
objects in the Shopping Cart.

You can drag the Shopping Cart to the Recycle Bin to
delete all the objects inside.

How to add or delete applications
To add or delete applications, click on "Application"

under the Tools menu.
The "Insert Applications" dialog box will appear (see

illustration below). This dialog box allows you to add or

delete applications.

¥ Bilma;lmagu
1| Erhancer Image
| Fax Viewer Dacument

eda Cip
' Miciosoft Office Binder
254 Microsolt Schedule 7.

"Add" and "OK" buttons to add the application.

-To remove an existing application, select the name of the

application in the right window. Click on "Remove" and

"OK" to remove the application. The name of the

application will disappear from the right window.




For more information on the IMS Shell please refer to the
IMS Shell on-line help.

Enhancer User Guide

Double clicking on this button on the IMS Shell
allows you to enter the Enhancer image processing software.
You can use the mouse to either drag or drop graphics

documents on this button, or just double click on the button.

® Tool Box: These buttons allow user to perform various
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kinds of image processing, such as selecting a
rectangular portion of the image, selecting a circular
portion of the image, selecting an irregular portion of the
image, selecting a similarly colored area (Magic Wand),
adding text, painting, and magnifying.

Palette: The Palette contains various color templates that
can be used to change the color of the background,
foreground, or within a selected area.

Brush Bar: These buttons allow the user to change the
shape, thickness, and transparency of brush strokes.
Status Bar: Displays image information and
explanations of commands.

Shortcut Bar: Allows user to quickly select image

processing commands and functions.

Opens a new image file

Opens an old image file

A

=] Prints an image file

¥4 Undoes the previous command
Cuts a selected portion of image
; j Copies selected portion of image

: Pastes image on clipboard to an image file

| Selects unselected portion of image and deselect

ortion that was originally selected.

Q Enlarges display of image on the screen
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¥ Shrinks display of image on the screen

2 Displays image in 1:1 ratio (that is, without adding or

subtracting any pixels)

of six functions, such as brightness, contrast, and tilt, etc.

(D) Scanning Example
(1) Scanning an image

Document must
face down

1. Open an image processing application. Place the
document to be scanned face down on the glass surface
of the scanner using the start arrow as a guide. Click on
"Prescan” to quickly preview the image.
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2. Use the mouse to select the area to be scanned using the
drag and zoom functions.

3. Set the resolution, brightness, contrast, and
magnification.
Click on "Scan” to generate an image.

5. Use the image processing application to edit the scanned
image.

6. Enter a filename and save the image file.

(2) Optical Character Recognition (OCR) of documents
Click on "Prescan” to quickly preview the document.

2. Use the mouse to select the area to be scanned using the
drag and zoom functions.

3. Select the "Line Art" mode and set resolution at 300dpi.

4. Click on "Scan" to scan the document and produce a
text image file.

Leave the scanner interface and enter the IMS Shell.
Select the OCR language (in the "Tools" menu of the
IMS Shell).

7. Use the mouse to drag the text image file to the icon of a
word processing application (such as Word, Wordpad,
etc.). The OCR function will automatically produce a
text file,

8. Use the word processor to correct, modify, and save the
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file.

. The "Line Art" scanning mode must always be used to
OCR a document Character recognition will be
impossible if "Line Art" is not selected.

. In the IMS Shell, OCR is performed by using the mouse
to drag the text image file onto the icon of a word
processing application. OCR takes place automatically
and the results are loaded in the word processor. There is
no special OCR dialog box and no independent OCR
icon.

. To OCR a Chinese text, drag the text image file onto the
icon of a Chinese word processor.

. The IMS Shel! contains 12 different OCR versions for
various languages. The user may select the language
versions to be used when installing the IMS Shell OCR
software (see page 10 ) and find them under the "Tools"
menu in the IMS Shell.
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Chapter 6 Scanner Care and Maintenance

(1) Cleaning the glass scanning surface:

Wipe the glass-scanning surface in a uniform direction.
Avoid marks from drops of water left on the glass surface.

(2) Moving the scanner:

Be sure the scanner lock is in the locked position prior to
moving. Unlock the scanner only after it is placed in a secure
location.

(3) To prevent the glass surface from being scratched, avoid
scanning sharp or hard objects or use extra caution when
doing so.

(4) To prevent the cover from deforming or damaging the glass,
avoid placing heavy objects on the scanner cover.
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Chapter 7 Troubleshooting and Technical Support

(1) Prior to installing the driver and applications programs, make
sure that there is enough disk space. We recommend that there
be at least 50MB of free disk space.

(2) If the [Scan] function is disabled while the scanner driver is
in operation, this function will be shown in gray:

1. Make sure the scanner power is ON and the indicator light
is lit. (Refer to Chapter 1)

2. Turn off the computer power and make sure that the signal
cable is securely attached.

(3) When using an application other than IMS, if scanning is slow
and results are poor, please check whether the application you
are using is a 16-bit or a 32-bit program. Select the driver
under [Select Source) as "E-SCANNER" for 16 bit
applications or "E-SCANNER32" for 32 bit applications.

(4) If the scanner stops functioning and emits a high-pitched noise,
make sure that the scanner is unlocked.

(5) If the power light does not come on but the scanner starts up
after the power has been switched on anyway, this indicates
that the power light is malfunctioning. If the scanner fails to
start up, check if the cable linking the computer is connected
properly and that the scanner is plugged in.

(6) If the message “Scanner Not Responding!!” appears when
attempting to scan an image, check whether power has been
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turned on to the scanner. If the scanner has power, make sure
the cable between the computer and the scanner is connected
securely.

{7) If the scanned image has streaks or lines, check:

1. Whether the monitor has been set at HI-COLOR (16-bit)
or higher,

2. Whether the scanned document is a printed article. If so,
make sure the "PRESS" option is selected before
performing scanning.

(8) If the scanner does not operate properly because of an
unfavorable work environment:

1. After closing applications and the scanner interface
program, turn the power switch off and then on again.
Open applications software and perform scanning tasks as
usual. Take the following steps if the problem persists:

2. Close all applications and tum off power to the scanner.

3. After restarting the computer, turn on power to the
scanner.

4. Open applications software and commence scanning

operations.
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Wichtige Sicherheitshinweise

Bitte lessen sie sich diese Hinweise sorgfaltig durch.

Heben Sie diese Anleitung fiir den spéteren Gebrauch auf.

Vor jedem reinigen ist das Great vom Stromnetz zu trennen.
Verwenden Sie Keine Fliissig-oder Aerosolreiniger. Am besten dient
gin angefeuchtetes Tuch Zur Reinigung.

Das Gerit ist vor Feuchtigkeit zu schittzen.

Die Beliftungsdffnungen dienen zur Lufizirkulation die das Great vor
Uberhitzung schiitzt.  Sorgen Sie dafir, dap diese Offnungen nicht
abgedeckt werden.

Verlegen Sie die NetzanschluBleitung so, da niemand dariiber fallen
kann. Es solite auch nichts auf der Leitung abgestellt werden.

Alle Hinmeise und Warnungen die sich am Geriten befinden sind zu
beachten. '

Wird das Gerit iiber einen lingeren Zeitraum nicht benutzt, sollten Sie
es vom Stromnetz trennen.  Somit wird im Falle einer Uberspannung
eine Beschidigung vermieden.

Durch die Liiftungsoffnungen diirfen niemals Gegenstidnde oder
Flissigkeiten in das Geriit gelangen. Dies kbnnte einen Brand bzw,
elektrischen Schlag ausldsen.

Offnen Sie niemals das Gertit.  Das Gerdt darf aus Griinden der
elektrischen Sicherheit nur von authorisiertem Servicepersonal gedffnet
werden.

Wenn folgende Situationen auftreten ist das Gerdt vom Stromnetz zu



trennen und von einer qualifizierten Servicestelle zu {iberprifen:

a. - Netzkabel oder Netzstecker sind beschidigt.

b.  Flissigkeit ist in das Gerdt eingedadigt.

¢. Das Gerar war Feuchtigkeit ausgesetzt.

4. Wenn das Gerit nicht der Bedienungsanleitung entsprechend
funktioniert oder Sie mit Hilfe dieser Anleitung keine
Verbesserung erziele.

e Das Gerit ist gefallen und/oder das Gehduse ist beschadigt.

£ Wenn das Gerit deutliche Anzeichen eines Defektes aufwelst.

7um Netanschlup Dieses Gerates ist eine gepriifte Leitung zu

verwenden. Fiir einen Nennstrom bis 6A und einem Gerategewicht
groper 3kg ist eine Leitung nicht leichter als HOSW-F mit einem

Leitungsquerschnitt von 00.75mm? einzusetzezen.

Dieses Schaltnetzeil kann bis zu einer Aufentemperatur von maximal

75 °C betieben werden.
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